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What’s New in V5.9

Added new tools to draw 2D roofs and specify line types optionally as user proceeds. Pitch can
be added but does not make the model 3D, simply modifies reporting.
Added new tool to measure Gable Roof pitches and hip pitches from a 2D raster image.
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Added Bulge option to Track-Outline dialog, allowing user to specify bulge factor and thus draw
a curved roof as a flat equivalent more easily.

L Chord Length

Added a new feature to Eave Offset for Roof Defaults where if a negative offset is entered, the
software asks the user whether to apply this to the eaves, or to leave the eaves where they are
and re-define the walls to this new location. Very useful for digitizing over aerial imagery and
still produce the wall lines.

Modified code so that Supplier replaces Manufacturer and links to the Supplier options under
Job-Info.

Modified Downpipe Definition dialog because certain fields were overlapping. Modified code to
allow user to change some of the labels such as Pop, Strap, Offset, Shoe and Elbow. User can do
this by defining file entitled “DPLabels.DAT.”



Added new feature to Dig-Roof / Dig-Plane to permit user to push mouse in a direction and then
type distance into prompt area. Selecting <Enter> then enters that line in the given direction.
Modified code to allow U/D/L/R buttons as well as C to be used for Digitize and Hole/Cut-Out
commands.

Added U/D/L/R commands to Draw Freehand in SmartLines.

Added a backup routine for complex roof layout to assist user who abnormally quits out of the
track outline routine.

Added option to change overhangs for single flat plane roofs. Also added in option to pre-select
pitching line so it doesn’t get forgotten.

Added new function to copy image from clipboard for raster underlays.
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Added Ship-Gable command to the menu to allow easy extension of gable without needing to
know how to use CAD stretch commands.

Modified Hole command so that it is now combined in the Cut-Out command.

Added wall batten calculations to ensure sheeting accessories for

wall battens calculate correctly. Fidure Options
Added calculation of wall areas and display of waste to Tally

Dialogs for wall panels. et

Added in Wall Labour Rates for Wall Tom and Bottoms for Height [B50000 |
variable labour costing. Label Fresie
Fixed flashing allowances dialog appearance for Walls.

Added new parametric functionality to Fixtures. This allows for Figwe Calowr  Ja—
Scaled Fixtures, as well as parametric box and cylinder Fittings. FisueWeight [o25
Added new Key Text String ###ParaFixtureList to output a table of Test Size Foo
label, length/diameter, width and height of respective parametric TewColow  Jo—
Fixtures. TewtWeight 0,25
Modified DownPipes code to remove “default” downpipe option. ﬂ|
This allows for up to 20 different downpipe types to be inserted

into the one model. Tally button added to the DownPipes menu



so that user can see what has been tallied without having to go to Supply & Install.

Added Split-Zone to the existing Zone functionality.

Added in 6 new Flashing Types:

ROOF_FLASH = -1, a flashing type that will appear for every roof flashing

WALL_FLASH = -2, a flashing type that will appear for every wall flashing

DOOR_FLASH = -3, a flashing type that will appear for all door flashings, edge and head
WINDOW_FLASH = -4, a flashing type that will appear for all window flashings, sill, edge and
head, WINDOOR_FLASH = -5, a flashing type that will appear for all window and door flashing
options.

ROOFWALL_FLASH = -6, a flashing type that will appear for every roof and wall flashing

Added option to allow number of elbows to be set to 2 if downpipe has an offset in it. User can
now modify total number of elbows also.

Modified Fall Protection code so that you can now apply multiple types of fall protection. Also
modified Pitch Break to Height as a new test. Ensured labour and material items write away and
that it is based on pitch, storey etc. as it wasn't previously.

Modified Linear Nesting code to add a “Max.” button that permits the longest sheet to be
calculated by the user. In addition, we have also added options to “Not split sheets on straight
cut boundaries” as well as to use the “Combine Sheet Lengths” value to bundle sheets into
similar lengths.
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Modified the selection of the sheets for a Linear Nesting job to get rid of all the longest straight-
cut sheets first. This provides better nesting as well as removing a portion of the easiest sheets
first, thus improving speed of nesting.

Modified Split-Panels command to allow user to simply specify length to cut sheets into.

Added option to allow the removal of [ ] around the panel length when annotating.

Modified code so that dimensioning and tallying of 2D roof planes works as expected, including
calculation of the roof area and percentage waste.

Added in support for AMS and Beck Automation rollformer output as well as AppliCad standard.
Zero Quantity Line items can now be shown/or not using option under Tools -> System-
Preferences.

Modified ###FlashingList Key Text String so that it only prints accessories for new formats within
Word and Excel.



Added Page Break back into the printout for Orders using AppliCad template.

Modified the Scroll List within Supply & Install so that it remembers its previous location.

Fixed issue where ###RoofDrawing and ###UnScaledRoofDrawing were not inserting into Excel
documents.

Show Plot Dialog option added to Tools -> Preferences dialog to allow users to determine
whether to display the Windows Printer dialog or just have the software print immediately.
Modified the Merge Product Codes option under Tools -> Preferences so that it now works for
both Tiles and Metal material types.

Added Stage-Manager option to Nett-Only Costing.

Added new function to permit the pre-setting of quote names for when Save button selected
within Quotation dialog. To use this, a file called QuotePresets.DAT can be created in the user
directory and an example entry, such as Standard Quote [Our Standard Quotation], will produce
the name “Standard Quote” with the item in square brackets serving as a comment for the user.
Modified Word and Excel code so that .DOC and .XLS files can be used instead of template files.
Added code to make all ###CostingDetails* table reports print as multi-page documents when
defined.

Added Auto-Print option for Word/Excel output.

Added option to allow the specification of Sheet List Text height as well as panel grouping in the
###SheetListTable and ###SheetLengthTable outputs.

Added ability to change any plane into a Zone Plane.

Added new option to turn on/off use of roof area when no panels applied to roof.

Issues Resolved Since 5.8 Release

Define Materials

Fixed issue where Finish button within the Define Mat’ls -> Fasteners dialog was not working.
Fixed issues relating to the saving away of Global Fittings and Manufacurer Fittings for Tiles+.
Fixed issue where Estimation Method for Miscellaneous Items was not working correctly.

Fixed issue where Finish button within the Define Mat’ls -> Flashings dialog was not working.
Fixed problem where Sheet Min and Max Lengths were being specified in mm.

Modified sheet accessories to use the same manufacturer as the sheet selected.

Fixed issue where first record of Flat Sheet was ALWAYS reporting as “Cut to Length”
irrespective of how it was saved away.

Fixed issue where Custom Flashings being added to Assemblies were just reporting as Flashingl,
Flashing2 etc. instead of displaying the Custom Profile name.

Fixed issue with the ellipsis button not working correctly on Assemblies dialog when modifying a
normal or custom flashing.

Job-Info

Modified functionality so that if a duplicate person record is found under Job menu it reports
any duplication but still updates the selected record.



Fixed issue where selecting Builder, then ok, displayed Customer percentage instead of saving
away the Builder record.

Fixed reading and saving of job stages in the Job Details dialog box.

Fixed issue of Job Details, Customer/Builder etc. records not saving away after being selected,
thus resulting in data loss on some occasions where user went straight to printing and did not
save away the model firstly.

Construct Roof

Circles not dividing into segments properly. Integer division resulted in number of segments
being 0.

Recover Outline Change -> Angle-Direction, could not change direction. Fixed.

Fixed issue where Curved Roofs were not displaying correctly nor could be covered.

Removed requirement to save model away when exporting an XML file as this is not possible
from some of our products, including RoofScape.

Updated prompts for the Verandah Dialog to make more sense as per training feedback.
Modified XML Import code to work correctly for looped planes (planes with holes).

Modified XML Export so that all units are degrees, and millimeters. Also modified output to only
include roof planes, thus excluding ceiling and gable planes.

Fixed issue with variable sometimes being uninitialized, crashing the software.

Modified Smart-Lines Draw-Freehand command to be iterative and to also remove some of the
clutter previously loaded into v5.8.

Modified Smart-Lines Trim-ZLine command to ask whether associated entities should be
stretched with line or remain where they are.

Merged functionality of Smart-Lines Trim-Line-End and Trim-Length commands to allow lines to
be trimmed to either a length or a plane defined by either 3 points, 2 lines are a plane entity.
Modified Insert-Gable-Roof command to insert Wall lines for projection and gable planes.
Changed Single-Hip and Singley-Valley commands to use Length when specified in SmartLines.
Added a new command to allow the insertion of a roof plane based on selection of an eave line
and then vertex points for the remainder of the plane.

Added ceiling plane for single panel roofs so wall lines don’t go missing when performing a
cutout.

Modify Roof

Extend-Barge command was re-colouring all line types. This has been rectified.

Modified Cricket command to allow side of line to be selected if attached to multiple planes.
Fixed code for hole generation as it wasn't removing the hole plane irrespective of whether you
said delete or keep the internal planes.

Modified software so that performing a cutout deletes any gable planes that cross the
intersection path.



Walls (Warlock-Only)

Fixed issue where Wall Labels were jumping to the centre of the wall model. They now appear
again on each wall.

Fixed issue where wall battens were not inserting in correct directions for some walls, especially
when a gable plane added to the top of an existing wall.

Removed Unblanking code as it resulted in the Undo/Redo for wall insertion breaking.

Added in a separate record for wall accessories as this was conflicting with roof sheeting
accessories.

Fixed issue where wall numbering was not working correctly, producing value of -1.

Added text annotation for Wall Flashings and ensure they print out on Drawings of Wall
Elevations.

Modified functionality of walls drawn in same aspect as roofs (flat on CPL) so sheet direction
always matches the plane hatching direction.

Added Merge-Collinear-Lines functionality to Wall Track-Edge so as to remove any collinear lines
created as part of tracking process.

Fixed issue of Wall Orders not deleting, thus resulting in the original wall order remaining,
irrespective of what was calculated subsequently.

Removed recursion of Wall Track command, thus preventing double-walls.

Merged 3 Project Walls commands into one.

Modified Link-Planes command to work for Walls also.

Added DisplayWall() command to Merge Planes so that they display properly after merging.
Modified Wall-Gable command to ask whether you want to merge the gable plane.

When we select Curved Metal, it modifies the straight structure and not the curved structure.
Modification of the text on blocking when altered. Used to print to 6 decimal places but
converted it back to 2.

If Barge-Only is used, Barge option wasn't appearing in the Flashing dialog.

Flashing options not sticking when selected, as well as always asking for updates when not
modified. Fixed.

Removed error regarding templates not existing within RWTMPLTS2.DAB

Fixed issue where some templates not printing due to file extension being duplicated
(“.DAB.DAB”)

Justification of replaced text was not working correctly. This is now rectified.

Fixed issue with Starter Course not calculating correctly for Shingles.

Inserting battens/purlins onto verandahs/porches had opposite effect depending on button
selection under Flashings -> Battens. This has been modified to work as expected.

Fixed issue where Special Tiles under Tiles+ were not saving away once selected.

Fixed issue within Tiles+ where Fittings were not saving away to the Temp directory as normal.
Load on the Flashing menu was not working at all. Issue has been resolved.



Fixed issue where fascia was being inserted on a Barge end because no other fascia was present
in the model and thus default value was being used despite not appearing.

Modified calculation of flashing update being required based on Manufacturer setting.

Fixed issue where Custom Flashing records were not being saved in the model for non-standard
lengths/angles.

Fixed issue that existing in 5.71 where “Combine Similar Length Flashing” value was only ever
being used from DEFAULT allowance set.

Added indication of Assembly File if one exists for Commercial Roofing.

Fixed issues with User Flashing types not appearing in the Cover -> Flashings menu option.
Modified the calculation of Battens2 to ensure they are kept separate from Battens calculations.
Also ensured that Pay Rates specified in Metal Pay Rates can be used to specify different install
rate.

Fixed issue where a coloured fastener was still using the wrong field of the fastener record when
displaying.

Modified the code to default the colour of a flashing to the colour of the roof material, if
selected.

Fixed issue with Battens not correctly being interpreted as part of a Stage in Stage Manager.
Fixed issue where Assemblies were not always calculating correctly for Custom Flashings defined
within them.

Fixed issue for Downpipe Quantities not calculating correctly for US units.

Fixed issue where accessories for flashings were crashing the software if Fascia/Gutter combo
button was selected after modifying the accessories once.

Modified Cover -> Select-Metal command so that roof planes repaint after selection.

Fixed repainting of deselected membrane roof panels.

Fixed issue where calculation of Membrane was resulting in an order amount of 1.0.

Fixed issue were modified accessories were not creating altered accessory lists upon Generation
within Cover -> Flashings.

Fixed issue where “Same as Ridge” would not save away as a System Default option.

Modified Tile selection code so that if no tile is selected, dialog does not display blanked tile.
Fixed issue where rounding of cutlists were resulting in Flashing lists being out of synch with the
drawing in the Flashing Profiles drawing.

Fixed issue where items such as insulation, fall protection etc. were not highlighting correctly.
Modified Barge Flashing prefix from “b” to “B”

Fixed issues where Active Stage was still remaining set after Stage Manager has been disabled.
Modified Batten/Purlin insertion so that code takes account of what Stage is currently selected.
Fixed issue where Wall Batten Lines, or User4 Lines, would deleted the cutting list records for
Ridges if a flashing type was specified.

Added User1 — User4 linetype options for Commercial Roofing.

Removed double-up of fastener output for Commercial Roofing.
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Fixed issue of “s” appearing prior to finish when using Single Line flashings.
Added description category items for DownSpouts/Downpipes to allow users to change names

and identify them easier in Supply & Install dialog.



Added Reset button to Accessories for Sheets and Flashings to allow setting back to original
defaults.

Fixed issue where Custom Profiles not being found because software was failing to check the
user directory.

Modified code so that battens now insert batten lines along fascia, gutter-only and fascia-only
for non-bottoms of planes.

Upgraded Flashing Selection dialog to allow selection of certain types of flashings.

Modified Flashing dialog opening / selection to remove sort. Greatly improves speed.

Added new functionality to allow assemblies to be modified on the fly for commercial cases.

Estimate

Fixed issue where lap directions would sometimes appear inside the model and sheets would
not match the lap/lay direction.

Fixed issue where Minimum Sheet Length was not being applied when selected by the user.
Modified the size of the Gen Offcuts text to match that of the Gen Panels text. This also ensures
the user can modify its size.

Fixed issue where modifying details or lengths on blocks resulted in the number of sheets being
rounded down. (truncated)

Fixed issue with commercial version of software not saving away proper user defined accessory
lists for sheeting. Also added in extra buttons for commercial roofing for setting up data sets.
Modified output of Feet/Inches code to ensure the software won’t produce dimensions of 212"
instead of 3'.

Reporting

If user adds a fastener using Add-Item, it adds the field twice, one with Qty of 1.0 and other with
a Qty of 0.0.

Job number was not being written to GRIM output files but instead a stupid number was
appearing.

If CSRDir was being used by customer then software overrides the directory with the working
directory.

Fixed issue with GRIM Export not working properly. Was adding WORKING_PATH twice!!
Get_Title() had incorrect index and thus we were printing out the wrong label for Drawings.
Notes were not printing out. Error caused by mismatch in text comparison. Use ###QQNOTE all
upper case as a workaround if customer doesn’t want to update software.

Quotes from 5.7 were crashing the system as well as not being able to read in old quotes (5.7
quotes)

Miscellaneous Items were not displaying for Labour Items.

Accessories now print for the ###FlashingList key text string.

Sheet Layout drawing not printing correctly. Fixed.

Number of stories saved away to be fixed at 10 so that the file reading and writing of Labour
Rates doesn't get confused.

Option for “Print Zero Quantity Line Items” now works as expected.

Markup options on dialog not providing capability to enter decimal points. Fixed.



Fixed issue where Custom Profiles were not appearing in the Costing output.

Fixed issue where Ridge Shingles were not being reported by bundle, even though this was the
pricing method selected.

Sped-up figure generation for Drawings and Reports.

Fixed issue where panel inserted atop an offset plane were not printing in Panel Layout drawing.
Fixed issue where Add-Item Straight/Curved caused a crash of the system.

Modified the way Totals and Rebates are tallied, so that they re-tally each time a user modifies
the quote details list.

Fixed issue where Miscellaneous Items were not inserting into the costing details list when
estimation method was set to “Mult. By Roof Area”

Fixed issue where lap directions were not printing for Panel Layouts.

Fixed issue where “Ga.” was being printed for flashings not using gauge. Only prints now when
gauge specified.

Fixed issues pertaining to quote groups not tallying properly both in reports and on the Costing
dialog.

Fixed issue where text was not coming out for Blocking Drawings.

Modified re-calculation of modification code for items in Supply&Install dialog in hope to speed
up performance over slow networks.

Modified acceptable Key Text String characters to include dash “-“ characters so that Quote
Group KTS work fine.

Modified the auto-expanding of the EPS output imagery for MS-Word templates so that scaling
of the image makes more sense and is less likely to be corrupted by cell sizing, padding etc.
Fixed issue with saving away images to Word and Excel documents.

Fixed issue where User Pay rates would not always read back in correctly.

Fixed issue where ###FascialLen and ###Gutterlen were reporting total quantities instead of per
storey. Also added in ###Userllen to ###UserdLen fro Word and Excel document output.
Ensured all column and row processing for Excel document output works the same way.

Added ###Bat2Mat to allow users to output Batten 2 material type.

Fixed issue where Labour rates were not printing zero quantities when Material rates were and
vice versa.

Reversed order of printing so that Roof Figures are only generated AFTER user selects what to
print, thus reducing time to print.

Fixed issue with flashing cutlists not aligning with proper item on order forms.

Re-Opened Material and Labour Sub-Total fields so that users can zero-out values for Materials
or Labour if required.

Removed re-calculation of job totals when returning from Printing, as this destroyed Rebate.
Updated Nett-Rates code to work as expected.

Added ###tFasciaCol and ###GutterCol into code to allow these to be output as they are often
different from the main roof colour.

Added Rebate/Extra and Sub-Total fields to ###CostingDetailsTable fields when Job Total has
been modified manually.



Fixed issue with Miscellaneous Items producing wrong description when outputting to the
Supply & Install dialog, as well as going out to the GRIM file.

Fixed issue where roof drawing was not bring updated when printing to Drawings Reports.
Fixed issue with missing cutlists for Straight and Curved sheeting, as well as some other
flashings. Fixed problem with cutlists doubling some items. Also removed possibility of cultists
getting out of synch with flashings in Order Form output.

Fixed issue where ###L| Key Text Strings were not calculating correctly within %CALC[] function.
Fixed issue where calculation of all fields not correct for Loading quotations within
Supply&Install dialog.

Removed scrolling of background image when scrolling within Supply&Install dialog.

Fixed software crash when saving quotation from Nett-Only quote.

Removed possibility of Curved Metal appearing in Supply&Install dialog when not selected for a
given job.

Added ###LINEITEM_BENDS and ###LINEITEM_GIRTH options to GRIM file output for Custom
Flashings.

Removed non-required linefeeds in the output of the GRIM files.

Prevented Tile Cartage from appearing for non-Magician/Sorcerer customers.

Fixed issue where Wall Battens and Batten 2 items were not appearing with cutlists for Order
Forms.

Fixed issue of Linefeeds and Carriage Returns not reporting correctly for Notes.

Fixed issue for Tiled Roofs where Cartage would sometimes not appear, whereas previously it
was appearing twice!

Added new functionality to allow modification of GRIM file Quote Output. Basic Information
only, Non-Zero Information, plus a range of options for Fabricated Items such as Custom
Profiles. Also added ability to select which quotes to output.

Removed deletion of Flashing Cutting List for when Stage Manager being used so as not to
remove cutting list entirely.

Modified code for Auto-Fill in Rates dialogs where intervals were not displaying correctly.
Modified functionality of Supply & Install dialog to ensure tabbing out of modifiable fields, such
as Labour SubTotal, Labour Markup etc. works as expected.

Removed “.Ga” as gauge text for values less than 4.

Added processing of Quote Groups for when Job Total has been manually modified.

Aligned output of values in GRIM file on a 30 character boundary as some field descriptions have
grown in size.

Fixed issue for Labour Quote Group Summary where printing of zero line items was reversed
from what it should have been.

Modified reporting output (Drawings and Reports) for Walls so as to include all Wall Line Types.
Some were not being included in the output.

Added layer 990 as a possible line layer for diagonal line in AppliCad Reports. Using this layer
results in a flashing drawing being output in place of the standard dimensioned drawing.
Added sheet width to profile output for Commercial Roofing applications.



Modified code so that zero quantity line items in the ###ExtrasList do not print out for the Key
Text String whenever it is specified.

Removed re-loading of customer discounts causing existing discounts added to be reset.

Fixed issue where Extra Items were not displaying if set to Labour category.

Fixed issue where gauge < 4.0 resulted in no gauge being displayed when Add-ltem added.
Fixed issue where left-clicking off Supply & Install dialog would quit dialog without saving.
Fixed issue where quitting out of Add-Item fasteners could crash Supply & Install dialog.

Fixed issue where Excel files were performing a File -> Save, thus the original template could get
overwritten. Now requires a Save-As, thus protecting the original template.

Fixed reporting of labour rates for Nett and Gross options under fixed metal setup.

Fixed issue for DownPipes not using correct dimension when displaying length in ft/inches.
Fixed issue where if ###HipLen is > 0, ensures that ###HipMat field is not set to "Not Included."
Fixed issue where insulation was not staying in the Roof Plane stage.

Fixed issue where accessories for flashings, when set to Labour, were not tallying correctly in
their respective quote groups.

Fixed quote saving code so that if too many quotes exist for the application pad record, then it
overflows to a BIN file with the quotes contained within.

Changed ##Ll_ code for Word and Excel to allow existing Categories to be used also. Works in
the same way but Categories cannot have spaces in their names - user needs to remove these.
Modified code so that ###SheetAccessList and ###FlashAccessList work properly. Also added
separate KTS of ###SheetLabAccessList and ###FlashLabAccessList.

Rake Tiles for Ridging displaying wrong tiles and manuacturer. Fixed.

Modified code so that all reports can have dimensions enabled by simply displaying them in the
model before printing.

Roof Quantities not printing out of Tally Quantities. Fixed.

Fixed problem where Barge-Only lines were not dimensioning.

Modified Key Text String in menu from ###Batteneltems to ###Battenltems

Modified output of the Tally Quantities layout option so that it all prints on one page.

Modified Edit-Templates dialog to use the same format as the Print Reports option. This allows
easier display of all user drawings and templates.

Added display of Active Stage to Display Tally so user can see what is being tallied.

Modified dimensioning code to ensure Feet/Inches dimensions round up properly.

General

Missing Colour Scheme application. Added back in.

Modified every list box in the software to create larger list box that also displays full width of
items using horizontal scrollbar. This also overcomes issues of not being able to display more
than 200 items in a scrollbox.

Fixed issue with modified flag always being set by new repaint code, thus asking whether we
wanted to save model away when nothing extra has been performed.

Modified list selection dialog so that OK button is not available until a valid selection is made.



END

Modified Repaint Icon so that if no filled planes exist in the model it just performs a normal
repaint, thus not removing and truetype text.

Changed labels in the entire software for Manufacturer and Distributor to “Supplier” so that
software has a consistent look and feel and makes more sense.

Fixed issue with scrolling of the middle mouse button while non-CAD dialog boxes are present.
Added functionality to print out a Summary Report of Shading, Insolation Yield and Temperature
Averages to an external CSV file for Solar Wizard.

Removed the request for the location of pitching lines for 2D planes when they can be
calculated.

Fixed a myriad of places where the scroll infout on the centre scroll button ceased to function.



